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1. Operatii I/O

Un flux de intrare/iesire (I/O) furnizeaza calea prin care programele pot trimite o secventa de
octeti de la o sursa catre o destinatie [7]. Un flux de intrare este o sursa (producétor) de octeti,
iar un flux de iesire este o destinatie pentru octeti (consumator). Desi fluxurile I/O sunt deseori
asociate cu accesul la figierele de pe disc, sursa si destinatia unui program pot fi, de asemenea,
tastatura, mouse-ul, memoria sau fereastra de afisare [9].

Citirea unui sir de la tastatura

&

Pentru citirea de la tastatura [7], pot fi folosite clasele DatalnputStream sau BufferedReader. Cu
DatalnputStream citirea se face in felul urmator:

DatalnputStream dis = new DatalnputStream(System.in);
String str = null;

try{
str = dis.readLine();

}

catch(IOException ioe){
ioe.printStackTrace();

}

In urmatoarea secventa citirea de la tastatura a unui sir de caractere se efectueaza folosind clasa
BufferedReader:

BufferedReader br = new BufferedReader(new InputStreamReader(System.in));
String str = null;

try{
str = br.readLine();

}
catch(IOException ioe){
ioe.printStackTrace();

}

Conversia unui sir de caractere st intr-un intreg se poate realiza folosind functia statica parselnt
a clasei Integer:

inti = Integer.parselnt(str);
Pentru conversia la float sau double se pot folosi:

float f = Float.parseFloat(str);
double d = Double.parseDouble(str);

Pentru  evitarea  exceptiilor, in cazul conversiilor trebuie tratatdi = exceptia
NumberFormatException.
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Citirea unui gir de caractere de la tastatura in C# se face cu functia readLine:
string str = Console.ReadLine();

Conversiile pot fi efectuate prin functiile clasei Convert. Exemple:

inti = Convert.Tolnt32(str);
double d = Convert.ToDouble(str);

Pentru evitarea exceptiilor, in cazul conversiilor trebuie tratatd exceptia FormatException.

Citirea dintr-un fisier

In exemplul urmitor, se afiseaza pe ecran toate liniile citite din fisierul input. txt.

&
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FilelnputStream fis = null;

try{
fis = new FilelnputStream("input.ixt");

}

catch(FileNotFoundException fnfe){
fnfe.printStackTrace();

}

DatalnputStream dis = new DatalnputStream(fis);

String str = null;

try{
while((str = dis.readLine()) != null)

System.out.printin(str);

dis.close();
System.in.read();

}
catch(IOException ioe){
ioe.printStackTrace();

}

[c¥

StreamReader sr = new StreamReader("input.txt");

string line = null;

while ((line = sr.ReadLine()) != null)
Console.WriteLine(line);

Console.ReadLine();

sr.Close();



Procesul de separare in simboluri

&
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Biblioteca Java uti/ defineste clasa StringTokenizer care faciliteaza separarea unui sir de
caractere 1n simboluri. Trebuie creat un obiect StringTokenizer, specificand sirul si delimitatorul.
Urmatoarea secventa de program afigeaza pe ecran simbolurile sirului delimitate prin caracterul
spatiu.

String psd = "Programarea Sistemelor Distribuite";

StringTokenizer st = new StringTokenizer(psd, " ");

while(st.hasMoreTokens())
System.out.printin(st.nextToken());

O alta posibilitate de separare a sirurilor de caractere in simboluri in limbajul Java este functia
split a clasei String. Urmatorul exemplu extrage dintr-o variabila de tip String cuvintele
delimitate prin spatii:

String str = “Hello world”;
String t[] = str.split(“ ”); //Rezultat: {*Hello”, “world™};
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In C# un sir poate fi separat in simboluri folosind functia Split a clasei string. Urmitorul
exemplu proceseaza un fisier intreg:

StreamReader sr = new StreamReader("input.txt");
string file = sr.ReadToEnd();
char [] separators = {"\n', ' '};
string [] values = file.Split(separators);
foreach (string v in values)
Console.WriteLine(v);
Console.ReadLine();
sr.Close();

Scrierea intr-un fisier

&
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Urmatoarea secventa de program scrie in fisierul data.txt intregul 10 si float-ul 3.14, apoi citeste
aceste valori din fisier si le afiseaza pe ecran.



try{
FileOutputStream fos = new FileOutputStream("data.txt");
DataOutputStream dos = new DataOutputStream(fos);
dos.writelnt(10);
dos.writeFloat(3.14f);
dos.close();

catch(IOException ioe){
ioe.printStackTrace();

}

try{
FileInputStream fis = new FilelnputStream("data.txt");

DatalnputStream dis = new DatalnputStream(fis);
System.out.printin(dis.readint());
System.out.printin(dis.readFloat());

dis.close();

catch(IOException ioe){
ioe.printStackTrace();

}
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Urmatoarea secventa de program scrie in figierul data.txt sirul de caractere “Hello World!”, apoi
il citeste din fisier si 1l afiseaza pe ecran.

StreamWriter sw = new StreamWriter("data.txt");
sw.WriteLine("Hellow World!");

sw.Close();

StreamReader sr = new StreamReader("data.txt");
Console.WriteLine(sr.ReadLine());
Console.ReadLine();

sr.Close();

Aplicatii

1. a) Citirea unui intreg de la tastatura;
b) Afisarea pe ecran a intregului citit;
2. a) Citirea unui float/double de la tastatura;
b) Sa se rotunjeasca in sus (Math.ceil()) valoarea citita si sa se afiseze rezultatul pe ecran;
c¢) Sa se rotunjeasca in jos (Math.floor()) valoarea citita si sa se afiseze rezultatul pe ecran;
d) Sa se rotunjeasca la intregul cel mai apropiat (Math.round()) si sa se afiseze rezultatul;
3. Sa se citeasca dintr-un figier un gir de ntregi si sa se afiseze pe ecran media aritmetica;



2. Fire de executie

Un fir de executie (thread) este o secventd de instructiuni ale unui program executabil.
Firul de executie principal este metoda main si atunci cand acesta se termind, se incheie si
programul. Programele pot executa in paralel doud sau mai multe fire de executie, dar in
realitate un singur fir se executd la un moment dat, comutand controlul de la un thread la altul

[9].
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Pentru implementarea unui fir de executie in Java, se poate extinde clasa Thread.
Deoarece Java nu accepta mostenirea multipld, in cazul in care a fost deja extinsa o clasa, pentru
crearea unui fir de executie trebuie implementatd interfata Runnable. Indiferent de metoda
utilizata, se suprascrie metoda run care trebuie sa contina instructiunile firului.

Aplicatia urmatoare porneste doud fire de executie: unul pentru afisarea numerelor si
celdlalt pentru afigarea literelor. Pentru a observa diferentele dintre cele doud metode de
implementare, firul de executie Numbers extinde clasa Thread, in timp ce Letters implementeaza
interfata Runnable.

public class Numbers extends Thread {
public void run(){
for(int i=0; i<1000; i++){
System.out.printin(i);
}
}
}

public class Letters implements Runnable {
chara="a"
public void run(){
for(int i=0; i<1000; i++){
intc =a+i%26;
System.out.printin((char)c);
}
}
}

public class Main {
public static void main(String[] args) {
Numbers numbers = new Numbers();
Thread letters = new Thread(new Letters());
letters.start();
numbers.start();
}
}

Pentru setarea prioritatii unui fir se apeleaza metoda setPriority a clasei Thread. De asemenea,
pentru a afla prioritatea unui fir se foloseste metoda getPriority. Pentru suspendarea unui fir de
executie pentru o perioada de timp precizatd in milisecunde, se utilizeazd metoda sleep a clasei
Thread.



[c¥

Pentru implementarea unui fir de executie n C# se foloseste clasa Thread. Urmatoarea aplicatie
de tip Console Application porneste doua fire de executie: unul pentru afigarea numerelor prin
functia numbers si celalalt pentru afigarea literelor prin funtia letters.

public class Fire

public Fire()
{

Thread numThread = new Thread(new ThreadStart(numbers));
Thread letThread = new Thread(new ThreadStart(letters));
letThread.Start();

numThread.Start();

}

public void numbers(){
for(int i=0; i<1000; i++)
Console.WriteLine(i);
}

public void letters(){
chara="a"
for(int i=0; i<1000; i++){
intc=a+i%26;
Console.WriteLine((char)c);

}
}

static void Main(string[] args)

{
new Fire();
Console.ReadLine();

}
}

Pentru blocarea unui fir de executie pentru o perioada de timp precizatd in milisecunde, se
utilizeaza metoda Sleep a clasei Thread. Firul de executie poate fi oprit temporar cu functia
Suspend, repornit cu functia Resume, respectiv oprit definitiv cu functia Abort a clasei Thread.

Lucrul cu imagini

Pentru a trasa o imagine in cadrul unei componente (ex. fereastrda), trebuie obtinut
obiectul Graphics al componentei respective [4]. In aplicatia urmitoare s-a implementat o
animatie simpla: deplasarea unei bile pe orizontala. Deplasarea bilei se face pe fir de executie.

&
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Aplicatia Java este formati din doud clase: Ball si MyFrame. Inainte de a muta bila pe noua
pozitie, ea trebuie stearsa de pe pozitia veche, si de aceea, pentru un scurt timp bila dispare de pe
fereastrd. Din aceastd cauza apare o palpaire in timpul deplasérii. Pentru eliminarea acestei
palpairi se poate implementa tehnica double buffering: desenarea se face mai intai intr-un buffer,
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si apoi se copiaza continutul bufferului pe fereastra aplicatiei [4]. Clasa Ball, instantiata in clasa
MyFrame, are urmatoarea structura:

public class Ball extends Thread {

int px = 0;
int py = 0;
int size = 0;

Color color = null;
MyFrame parent = null;
Image buffer = null;

public Ball(MyFrame parent, int px, int py, int size, Color color) {
this.parent = parent;
this.px = px;
this.py = py;
this.size = size;
this.color = color;
buffer = parent.createlmage(parent.getSize().width, parent.getSize().height);

}

void paint()}
Graphics gbuffer = buffer.getGraphics();
/Ise deseneaza mai intai in buffer (tehnica Double Buffering)
gbuffer.setColor(Color.white);
gbuffer fillRect(0, 0, parent.getSize().width, parent.getSize().height);
gbuffer.setColor(color);
gbuffer fillOval(px, py, size, size);
parent.paint(gbuffer);
/Ise copiaza imaginea din buffer pe fereastra (tehnica Double Buffering)
Graphics g = parent.getGraphics();
g.drawlmage(buffer, 0, 0, parent.getSize().width, parent.getSize().height, 0, 0, parent.getSize().width,
parent.getSize().height, parent);
}

public void run(){
while(px < parent.getSize().width){
px++,
paint();
}
}
}

Clasa MyFrame are urmatoarea structura:

public class MyFrame extends Frame {
Ball ball = null;

public MyFrame() {

try {
jblnit();

catch (Exception e) {
e.printStackTrace();

setVisible(true);
ball = new Ball(this, 20, 50, 20, Color.red);
ball.start();



private void jbinit() throws Exception {
this.setSize(new Dimension(400, 300));
this.setTitle("Balls");
this.addWindowListener(new java.awt.event.WindowAdapter() {
public void windowClosing(WindowEvent e) {
this_windowClosing(e);
}
s
}

void this_windowClosing(WindowEvent e) {
System.exit(0);
}

[c¥

Aplicatia C# de tip Windows Application este formata din doua clase: Ball si MyForm. Clasa
Ball, instantiatd in clasa MyForm, are urmatoarea structura:

public class Ball
{
int px = 0;
int py = 0;
int size = 0;
Color color;
MyForm parent = null;
Thread bthread = null;

public Ball(MyForm parent, int px, int py, int size, Color color)

{
this.parent = parent;
this.px = px;
this.py = py;

this.size = size;

this.color = color;

bthread = new Thread(new ThreadStart(run));
bthread.Start();

}

public int getPX()
{

return px;

}

public int getPY()
{

return py;

}

public int getSize()
{

return size;

}

public Color getColor()
{

return color;

}
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public void terminateBallThread()

bthread.Abort();
}

public void run()

{
while (px < parent.Size.Width)

Thread.Sleep(20);
pX++;
parent.Refresh();

}
}
}

Clasa MyForm are urmétoarea structura:
public partial class MyForm : Form
Ball ball = null;

public MyForm()
{

InitializeComponent();
CheckForlllegalCrossThreadCalls = false;
this.BackColor = Color.White;

ball = new Ball(this, 0, 50, 20, Color.Red);

}

private void MyForm_Load(object sender, EventArgs e)

{
this.Size = new Size(400, 300);
this.Name = "Balls";

}

private void MyForm_Paint(object sender, PaintEventArgs €)

{
SolidBrush brush = new SolidBrush(Color.White);

e.Graphics.FillRectangle(brush, 0, 0, Size.Width, Size.Height);

brush = new SolidBrush(ball.getColor());

e.Graphics.FillEllipse(brush, ball.getPX(), ball.getPY(), ball.getSize(), ball.getSize());
brush.Dispose();

}

private void MyForm_FormClosing(object sender, FormClosingEventArgs €)

ball.terminateBallThread();

}
}

Atentie, figierul MyForm.cs se va genera automat, urmand sa-1 completati conform clasei
MyForm de mai sus. Evenimentelor Load, Paint si FormClosing trebuie asociate functiile
corespunzatoare ~ (MyForm Load, @ MyForm Paint si  MyForm FormClosing) 1in
Design/Properties/Events!
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In aplicatia C# tehnica double buffering se activeaza setand pe True proprietatea DoubleBuffered
in Design/Properties.
Aplicatii

1. Sa se dezvolte clasa Ball din aplicatia prezentatd pentru modelarea miscarii unei bile
folosind urmatorul algoritm:

gravy = 1;
speed = -30;
speedy = -30;
speedx = 0;

while(true {

speedy += gravy;

py += speedy;

px += speedx;

paint();

if(py > frameheight){
speedy = speed,;
speed += 3;

if(speed == 0) break;

}

2. Sa se modifice clasele MyFrame si Ball in asa fel incat sd poatd fi pornite mai multe bile
simultan.

3. Sa se realizeze o aplicatie care sd afiseze reclamele, cate 5 secunde fiecare, intr-o bucla
infinitd. Fiecare reclamad are o anumita prioritate si in functie de aceasta, ea apare cu o
anumita frecventa. Caile imaginilor si prioritatile acestora vor fi preluate dintr-un fisier.

Indicatii pentru aplicatia 3

&

-

Pentru incarcarea unei imagini in Java se foloseste metoda getlmage a clasei Toolkit. Una din
metodele de a obtine obiectul Toolkit este prin folosirea metodei statice getDefaultToolkit a
clasei Toolkit. Pentru preincarcarea imaginilor in memorie, se foloseste clasa MediaTracker.
Metoda waitForld a clasei MediaTracker permite incarcarea imaginilor care au un anumit ID
(mai multe imagini pot avea acelasi ID). ID-urile se seteaza la adaugarea imaginilor in obiectul
MediaTracker. Metoda waitForAll 1incarca In memorie toate imaginile addugate in obiectul
MediaTracker. Dupa ce imaginile au fost incarcate ele pot fi desenate pe orice componenta
folosind metoda drawlmage a clasei Graphics. Urmatoarea secventa de program incarca doua
imagini:

Image imgA = null;
Image imgB = null;

12



MediaTracker mt = new MediaTracker(this); // this - fereastra
imgA = Toolkit.getDefaultToolkit().getimage(“A.gif");
mt.addlmage(imgA, 0);

imgB = Toolkit.getDefaultToolkit().getimage(“B.gif");
mt.addlmage(imgB, 0);

try{
mt.waitForAll();

catch(InterruptedException e)

e.printStackTrace();

[c¥

Pentru incircarea unei imagini in C# se poate folosi clasa Bitmap, iar desenarea imaginii pe
fereastrd poate fi efectuatd cu functia Drawlmage a clasei Graphics. Pentru asta, trebuie obtinut
obiectul Graphics al ferestrei sau al componentei pe care se doreste sa se afiseze imaginea:

private void MyForm_Paint(object sender, PaintEventArgs e)

{
Bitmap bmp = new Bitmap("c:\\t.bomp");
e.Graphics.Drawlmage(bmp, 0, 0, new Rectangle(0, 0, Size.Width, Size.Height),
GraphicsUnit.Pixel);
}
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3. Sincronizarea firelor de executie

Exista mai multe metode de sincronizare a firelor de executie [2], cea mai frecvent
utilizata fiind sincronizarea prin semnalizare. In continuare, va fi prezentata o aplicatie simpla,
rezolvarea ecuatiei de gradul 2.

&

Daca in cadrul unui program Java exista un fir de executie care creeaza (produce) date si un al
doilea fir de executie care le prelucreaza (consuma), de reguld se declard un bloc synchronized,
ceea ce permite ca un singur fir sd aiba acces la resurse (metode, date) la un moment dat. Astfel,
sincronizarea se face prin asteptare. Atunci cand un fir de executie apeleaza wait in cadrul unui
bloc de cod synchronized, alt fir poate accesa codul. Iar atunci cand un fir de executie incheie
procesarea codului synchronized, el apeleaza metoda notify pentru a anunta alte fire de executie
si inceteze asteptarea. In cazul rezolvirii ecuatiei de gradul 2 — aplicatie prezentati in continuare
— firele #x/ respectiv #x2 asteapta notificarea firului tdelta:

public class Ec2{
private Thread_X1 tx1;
private Thread_X2 tx2;
private Thread_Delta tdelta;

inta=1;
intb =-4;
intc=1;

double x1, x2;
Double d = null;

public Ec2() {
tx1 = new Thread_X1(this);
tx2 = new Thread_X2(this);
tdelta = new Thread_Delta(this);

tx1.start();
tx2.start();
tdelta.start();

}

public synchronized void delta(){
d = new Double(b*b - 4*a*c);
System.out.printin("delta =" + d);
System.out.printin("tdelta: sleeping");

try {
Thread.sleep(5000);

catch (InterruptedException ex) {
ex.printStackTrace();

}
this.notifyAll();
System.out.printin("tdelta: notified");
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public synchronized void x1(){
if(d == null){
System.out.printin("tx1: waiting...");

try {
this.wait();

catch (InterruptedException ie) {
ie.printStackTrace();

}

}
x1 = (-b + Math.sqrt(d.doubleValue())) / (2 * a);

System.out.printin("x1 =" + x1);

}

public synchronized void x2(){
if(d == null){
System.out.printin("tx2: waiting...");

try {
this.wait();

catch (InterruptedException ie) {
ie.printStackTrace();

}

}
X2 = (-b - Math.sqrt(d.doubleValue())) / (2 * a);
System.out.printin("x2 =" + x2);

}

public static void main(String[] args) {
new Ec2();
}
}

public class Thread_Delta extends Thread{
Ec2 ec2;

public Thread_Delta(Ec2 ec2) {
this.ec2 = ec2;

}

public void run(){
ec2.delta();

}
}

public class Thread_X1 extends Thread{
Ec2 ec?;

public Thread_X1(Ec2 ec2) {
this.ec2 = ec2;

}

public void run(){
ec2.x1();
}
}
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public class Thread_X2 extends Thread{
Ec2 ec2;

public Thread_X2(Ec2 ec2) {
this.ec2 = ec2;

}

public void run(){
ec2.x2();

}
}

[c¥

AutoResetEvent si ManualResetEvent permit firelor de executie sid comunice intre ele prin
“semnalizare”. Un fir asteaptd un “semnal” apeland WaitOne pe ManualResetEvent (sau
AutoResetEvent). Dacd ManualResetEvent este 1n starea nesetat, firul se blocheaza si asteapta
pana cand acesta ajunge 1n starea setat, in urma apelului metodei Sez. Astfel, daca in cadrul unui
program exista un fir de executie care creeaza (produce) date si un al doilea fir de executie care
le prelucreaza (consuma), firul consumator asteapta pana cand este activat de firul producator.
In cazul rezolvirii ecuatiei de gradul 2 — aplicatie prezentati in continuare — firele £x/ respectiv
tx2 asteapta notificarea firului tdelta:

using System;

using System.Collections.Generic;
using System.Text;

using System.Threading;

namespace ec2

{

class Program

{

static void Main(string[] args)

new Ec2();

}
}

public class Ec2
{
inta=1;
intb = -4;
intc=1;
Double x1, x2, d;
static ManualResetEvent deltaReady = new ManualResetEvent(false);

public Ec2()

{
Thread tx1 = new Thread(new ThreadStart(ComputeX1));
Thread tx2 = new Thread(new ThreadStart(ComputeX2));
Thread tdelta = new Thread(new ThreadStart(ComputeDelta));
tdelta.Start();
tx1.Start();
tx2.Start();
Console.ReadLine();
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public void ComputeDelta()

d=b*b-4*a*c;
Console.WriteLine("delta =" + d);
Console.WriteLine("tdelta: sleeping");
Thread.Sleep(5000);
Console.WriteLine("tdelta: ready");
deltaReady.Set();

}

public void ComputeX1()
{

Console.WriteLine("tx1: waiting...");
deltaReady.WaitOne();

x1 = (-b + Math.Sqrt(d)) / (2 * a);
Console.WriteLine("x1 =" + x1);

}
public void ComputeX2()

Console.WriteLine("tx2: waiting...");
deltaReady.WaitOne();

x2 = (-b - Math.Sqrt(d)) / (2 * a);
Console.WriteLine("x2 =" + x2);

}
}
}

Aplicatii

1. Sa se implementeze aplicatia prezentata in lucrare.

Sa se implementeze cazul clasic de partajare a datelor: problema producator/consumator.
Sa se implementeze o aplicatie vizuala: sincronizarea liftului cu locatarii intr-un bloc,
sincronizarea calatorilor cu o linie de autobuz.

wnN

17



4. Aplicatii client-server

Retelele fac posibile multe tipuri noi de aplicatii, deoarece nu mai este necesar ca un
singur calculator si execute totul [4]. In cadrul unei retele, citeva calculatoare, denumite
servere, efectueaza activitati specializate in folosul altor programe. Serverul este un program
specific care ruleaza in mod continuu, cu unicul scop de a furniza un serviciu altor programe.
Clientul, pe de alta parte, este un program care primeste servicii de la un server.

Pentru a scrie aplicatii client-server [15], trebuie create doud programe: clientul si
serverul. In cadrul acestor programe, trebuie definit modul cum comunica cele doud programe,
modul de interactiune dintre ele. Regulile de comunicare pe care trebuie sa le respecte ambele
programe. Se numesc protocoale.

Atunci cand doua aplicatii trebuie sd comunice, ele trebuie sa se gaseasca reciproc. Daca
doua aplicatii isi cunosc reciproc soclul, ele pot crea o conexiune de soclu. De obicei este
responsabilitatea clientului sa caute serverul initializand o conexiune de socluri. Serverul creeaza
un soclu pe care 1l va utiliza pentru comunicarea cu clientul si isi transmite propria adresd de
soclu catre aplicatia client in primul sdu mesaj de raspuns [15].

«

Pentru implementarea aplicatiei client in Java, se foloseste clasa Socket precizand IP-ul
respectiv portul serverului. Pentru crearea unui server in Java, se foloseste clasa ServerSocket,
precizand portul serverului. Apoi serverul apeleazd metoda accept pentru a astepta conectarea
unui client. Atunci cand un client lanseazd o cerere de conectare, metoda accept returneaza
soclul clientului (obiect prin care se va realiza comunicarea dintre cele doud aplicatii). In
aplicatia urmatoare, clientul trimite o valoare serverului, iar serverul primeste valoarea si o
afigeaza. Aplicatia se va testa pornind prima data serverul si apoi clientul.

public class MyClient {
InputStream in = null;
OutputStream out = null;
DatalnputStream Dataln = null;
DataOutputStream DataOut = null;
Socket clientSocket = null;

public MyClient() {
try {
clientSocket = new Socket(“localhost”, 8000);
sendInt(100);

catch( UnknownHostException e) {
e.printStackTrace();

}

catch(IOException e) {
e.printStackTrace();

}

}

public void sendInt(int val) throws IOException{
out = clientSocket.getOutputStream();
DataOut = new DataOutputStream(out);
DataOut.writelnt(val);
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public void receivelnt() throws IOException{
in = clientSocket.getlnputStream();
Dataln = new DatalnputStream(in);
int val = Dataln.readlInt();
System.out.printin(val);

}

public static void main(String args[]}{
new MyClient();
}

public class MyServer implements Runnable{
private Socket socketReturn;
InputStream in = null;
OutputStream out = null;
DatalnputStream Dataln = null;
DataOutputStream DataOut = null;

public MyServer(Socket s) throws IOException {
socketReturn = s;
receivelnt(); // Clientul incepe, deci serverul asteapta valoarea

}

public MyServer() {
Thread thread = new Thread(this);
thread.start();

}

public void sendlInt(int val) throws IOException{
out = socketReturn.getOutputStream();
DataOut = new DataOutputStream(out);
DataOut.writelnt(val);

}

public void receivelnt() throws IOException{
in = socketReturn.getlnputStream();
Dataln = new DatalnputStream(in);
int val = Dataln.readInt();
System.out.println(val);

}

public void run(){
ServerSocket s = new ServerSocket(8000);

try {
while(true
Socket socket = s.accept();
try {
new MyServer(socket);

}

catch(IOException €)
socket.close();

}

}

finally {s.close();}
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public static void main(String args[])}{
new MyServer();
}

[c¥

Pentru implementarea aplicatiei client in C#, se foloseste clasa TepClient precizand IP-ul
respectiv portul serverului. Pentru crearea unui server in C#, se foloseste clasa TcpListener,
precizand portul serverului. Apoi serverul apeleazd metoda AcceptTcpClient pentru a astepta
conectarea unui client. Atunci cand un client lanseaza o cerere de conectare, metoda
AcceptTcpClient returneaza soclul clientului (un obiect de tip TcpClient), prin care se va realiza
comunicarea dintre cele doud aplicatii. In aplicatia urmitoare, clientul trimite o valoare
serverului, iar serverul primeste valoarea si o afiseaza. Aplicatia se va testa pornind prima data
serverul si apoi clientul.

using System;

using System.Collections.Generic;
using System.Text;

using System.Net.Sockets;

using System.IO;

using System.Threading;

namespace client

class MyClient

{
TcpClient client = null;
NetworkStream stream = null;
StreamReader streamReader = null;
StreamWriter streamWriter = null;

public MyClient()

{
client = new TcpClient("localhost", 8000);
stream = client.GetStream();
streamReader = new StreamReader(stream);
streamWriter = new StreamWriter(stream);
sendInt(100);
stream.Close();
client.Close();

}

public void sendInt(int val)

{
streamWriter.WriteLine(Convert. ToString(val));
streamWriter.Flush();

}

public void receivelnt()

{

int val = Convert.Tolnt32(streamReader.ReadLine());
Console.WriteLine(val);

}
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using System;

using System.Collections.Generic;
using System.Text;

using System.Net.Sockets;

using System.IO;

using System.Threading;

namespace server

class MyServer

{

TcpListener server = null;
NetworkStream stream = null;
StreamReader streamReader = null;
StreamWriter streamWriter = null;

public MyServer(TcpClient clientSocket)
{

stream = clientSocket.GetStream();
streamReader = new StreamReader(stream);
streamWriter = new StreamWriter(stream);
receivelnt();

stream.Close();

}
public MyServer()

Thread thread = new Thread(new ThreadStart(run));
thread. Start();

}

public void sendInt(int val)

{

streamWriter.WriteLine(Convert. ToString(val));
streamWriter.Flush();
}

public void receivelnt()

{

int val = Convert.Tolnt32(streamReader.ReadLine());
Console.WriteLine(val);

}

void run()

{

server = new TcpListener(8000);
server.Start();

while (true)

TcpClient clientSocket = server.AcceptTcpClient();
new MyServer(clientSocket);

}
}
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Aplicatii
1. Sa se implementeze aplicatia prezentata in lucrare.

2. Sa se modifice aplicatia prezentatd in lucrare astfel incat clientul sa trimitd serverului
mesajul Hello Server iar serverul sa raspunda Hello Client.

3. Realizarea unei aplicatii client-server pentru listarea fisierelor text la imprimanta. Aplicatia
va avea urmatorul protocol de comunicare:

Server Client

¢ arhivare fisier (ZIP)

dimensiune ZIP
< L 4

trimite arhiva in pachete de 1K
< °

dezarhivare figier (ZIP) ¢

listare la imprimanta ¢

Figura 1. Transfer de figiere

Indicatii pentru aplicatia 3

Asa cum se poate observa in secventele urmatoare, arhivarea i dezarhivarea se vor face folosind
clasele ZipOutputStream si respectiv ZipInputStream. Pentru listarea fisierului la imprimanta se
poate folosi clasa PrintJob.

&

SERVER (dezarhivare)

try{
FilelnputStream fileIn = new FilelnputStream(zip);

FileOutputStream fileO = new FileOutputStream(numeFisier);
ZiplnputStream zipln = new ZiplnputStream(fileln);
zipln.getNextEntry();
int m;
while((m = zipln.read()) != -1)
fileO.write(m);
fileln.close();
fileO.close();
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catch(ZipException e){
System.out.printin(e.toString());
}

CLIENT (arhivare)

try{
FilelnputStream fileIn = new FilelnputStream(fisier);
FileOutputStream f = new FileOutputStream(zip);
ZipOutputStream zipOut = new ZipOutputStream(f);
zipOut.putNextEntry(new ZipEntry(fisier));
int m;
while((m = fileln.read()) != -1)
zipOut.write(m);
zipOut.close();
fileln.close();
f.close();
}

catch(ZipException e){
System.out.printin(e.toString());
}

Listarea la imprimanta

PrintJob job=Toolkit.getDefaultToolkit().getPrintdob(this, " Print ",(Properties)null );
if (job==null) return;

Graphics pg = job.getGraphics();

pg.setFont(new Font("Times new roman",Font.BOLD,12));
pg.drawString("Programarea Sistemelor Distribuite”, 100, 15);

job.end();

[ct

Pentru listarea la imprimanta in C#, exista componente vizuale in Toolbox, in categoria Printing.

4.

Sa se modifice aplicatia 3 in asa fel incat ea sa functioneze corect si in situatia in care
anumite pachete de date se pierd si nu ajung la server. Modificarea consta in retransmisia
pachetelor pierdute.

Realizarea unei aplicatii client-server pentru apelul functiilor la distanta:
e clientul cere apelul unei functii cu anumiti parametri;
e serverul apeleaza functia si trimite rezultatul aplicatiei client.

Sa se dezvolte aplicatia 5 prin introducerea unei strucuri de tip buffer, care sd retina
rezultatele celor mai frecvente operatii efectuate. In cazul in care rezultatul unei operatii este
gasit in acest buffer, operatia respectiva nu se mai efectueaza, rezultatul transmis aplicatiei
client fiind cel din buffer.

Sa se implementeze o aplicatie de chat.
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Indicatii pentru aplicatia 7

Aplicatia va fi formatd din programul server respectiv programul client. Clientul va avea o
interfata graficd (Figura 2) formatd din urméitoarele componente: lista clientilor conectati, lista
de mesaje, casutd de editare pentru introducerea mesajelor, buton SEND pentru trimiterea
mesajului introdus catre clientul selectat. Receptionarea mesajelor se va face intr-o bucla infinita
implementata pe un fir de executie.

Client 1
Client 2 Lista de mesaje THREAD
while(true)
Client k « RECEIVE MESSAGE
Client n 4
Editare mesaj... | | Send |~— SEND MESSAGE

Figura 2. Aplicatia client

Aplicatia server, prezentatd in Figura 3, pastreaza clientii (soclu, nume, etc.) intr-un vector.
Pentru fiecare client conectat creeaza cate un fir de executie (thread) care, intr-o bucla infinita,
receptioneaza mesajele de la clientul respectiv si apoi le trimite mai departe clientului destinatie.
Conectarea clientilor se face la fel ca 1n aplicatia prezentata in lucrare. La conectarea unui nou
client serverul trebuie sd anunte toti clientii pentru actualizarea listelor de clienti. De aceea, in
afard de mesajele propriu-zise vor exista si mesaje speciale (de administrare) pentru addugarea
clientilor conectati respectiv stergerea clientilor deconectati. Diferentierea dintre cele doua tipuri
de mesaje se poate efectua prin utilizarea unui antet (header) in cadrul mesajului.

VECTOR = { Client 1, Client 2, ..., Client n }

Client 1 Client n
THREAD THREAD

RECEIVE RECEIVE
SEND SEND

Figura 3. Aplicatia server
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5. Conectarea la o baza de date MySQL
&

-

JDBC (Java Database Connectivity) este o interfatd API (Application Program Interface)
realizatd de Sun, care permite unui program Java accesul la un SGBD (Sistem de Gestionare a
Bazelor de Date). JDBC permite conectarea la baza de date si executa instructiunile SQL.

Proiectul contine doud clase principale: DBConnection si DBFrame. In constructorul
clasei DBConnection se incarca in memorie driverul necesar pentru realizarea unei conexiuni la
o baza de date MySQL.:

Class.forName(driver);

Apoi are loc conectarea la baza de date database:

"o "on

con = DriverManager.getConnection("jdbc:mysql://IP/database/", "user", "password");

unde IP este adresa IP a calculatorului pe care se afla baza de date database si pe care trebuie sa
fie pornit un server de MySQL. Pentru testare locald, in loc de IP se foloseste localhost. In cazul
unei baze de date locale adresa IP nu trebuie precizata:

"non "non

con = DriverManager.getConnection("jdbc:mysql:database”, "user”, "password");

Clasa DBConnection poate fi definita in felul urmator:

import java.sql. *;

public class DBConnection {
private String driver = "org.gjt.mm.mysql.Driver";
public Connection con = null;

public DBConnection(String database, String user, String password) throws Exception{
Class.forName(driver),;
con = DriverManager.getConnection("jdbc:mysql://localhost/” + database + “/", user, passw),;

DBConnection va contine si metodele prin care se vor insera date in tabele sau metodele
prin care se vor interoga aceste tabele. Toate aceste operatii se vor realiza prin intermediul unui
obiect Statement:

Statement statement = con.createStatement();

Inserarea se face cu metoda executeUpdate a clasei Statement. De exemplu, pentru adaugarea
inregistrarii Popescu 1n tabela student, care are un singur camp Nume, se procedeaza in felul
urmator:

statement.executeUpdate("insert into student (Nume) values ('Popescu’)");

Asa cum se poate observa in urméatoarea secventd, obtinerea rezultatelor unei interogari se
realizeaza prin intermediul unui obiect de tip ResultSet:

ResultSet rs = statement.executeQuery("select * from student”);
while(rs.next()){

System.out.printin(rs.getString("Nume"));
}
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In constructorul clasei DBFrame se creeazi un obiect de tip DBConnection, prin
intermediul caruia va putea fi apelata oricare din metodele acestei clase:

try{
connection = new DBConnection(nume_baza_de_date, nume_utilizator, parola);

catch(Exception exc){
exc.printStackTrace();
}

Observatie:

Pentru conectarea aplicatiei la un server MySQL, in proiect trebuie inclusa libraria care contine
driverul de MySQL: mm.mysql-2.0.12-bin.jar. Daca lucrati cu Java Builder, libraria se incarca
din “Project\Project Properties\Required Libraries”.

[c¥

Aplicatia C# prezentatd in continuare, se conecteazd la o bazd de date Student creatd in
Microsoft SQL Server. Urmatorul exemplu prezintd conectarea la baza de date din SQL Server,
unde connectionString se poate prelua din proprietatile bazei de date.

using System.Data.SqlClient;

string connectionString = @"Data Source=(local);Initial Catalog=Student;Integrated Security=True";
SqlConnection sqlConnection = new SglConnection(connectionString);
sqlConnection.Open();

Interogarea bazei de date se poate realiza dupa cum urmeaza:

string query = "SELECT * FROM dbo.Student";
SqlCommand sqlCommand = new SqglCommand(query, sqlConnection);
SqlDataReader sqlDataReader = sqgiCommand.ExecuteReader();
while (sqlDataReader.Read())
Console.WriteLine(sglDataReader.GetValue(0) + "; " + sglDataReader.GetValue(1) + "; " +
sglDataReader.GetValue(2));
sqlCommand.Dispose();
sqlDataReader.Dispose();

Pentru inserare, modificare si stergere se vor folosi comenzi de tip ExecuteNonQuery().

Aplicatii

1. Sa se implementeze o aplicatie pentru conectarea la o baza de date create in SQL Server care
pastreza informatii despre student. Aplicatia trebuie sd aiba o interfatd care sa permitd
vizualizarea (interogarea) tabelelor unei baze de date si introducerea unor noi inregistrari.

2. Dezvoltati aplicatia 1, prin introducerea functiilor care sd permitd modificarea si respectiv
stergerea Inregistrarilor existente.
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6. Aplicatii web

@

O varianta de aplicatie web Java este Servletul. Servleturile sunt componente
independente de platforma ale aplicatiilor server si au suport Java integrat [ 12]. Ele sunt
independente de protocol, asigurand un cadru general pentru servicii pe baza modelului cerere-
raspuns. Acest binecunoscut model este des folosit la programarea sistemelor distribuite,
incepand cu apeluri de proceduri la distanta si terminand cu protocolul HTTP pentru cereri catre
servere web. Cu ajutorul servlet-urilor extindem deci functionalitatea unei aplicatii de tip server
informational (nu neapéarat server HTTP), un prim domeniu de aplicare fiind, bineinteles,
extinderea serverelor web.

Pentru rularea servlet-urilor se poate utiliza un server Tomcat, inclus in Jbuilder 7.
Servlet-urile trebuie copiate in Root sau intr-un director nou creat in directorul webapps din
Tomcat, si in functie de asta, trebuie sa aiba urmatoarea structura:

Tip figier Root Nume_Aplicatie

html Webapps\Root\*.html Webapps\Nume_Aplicatie\*.html

class Webapps\Root\Web-inficlasses\*.class | Webapps\Nume_Aplicatie\Web-inf\classes\*.class
jar Webapps\Root\Web-infllib\*.jar Webapps\Nume_Aplicatie\Web-infllib\*.jar

Tabel 1. Structura unui servlet

In functie de directorul (Root sau Nume Aplicatie) si respectiv statia pe care se afla servlet-ul,
cererea HTML va fi urmatoarea:

IP Port | Root Nume_Aplicatie

localhost 8080 | http://localhost:8080/*.html http://localhost:8080/Nume_Aplicatie/*.html

192.168.25.99 | 8080 | http://192.168.25.99:8080/*.html | http://192.168.25.99:8080/Nume_Aplicatie/*.html

Tabel 2. Cerer1 HTML

Aplicatia urmatoare este formata dintr-un HTML care permite introducerea unui nume si
apoi la apasarea unui buton lanseaza o cerere spre servlet-ul Hello, care raspunde cu mesajul
Hello nume. Clasa Hello are urmatoarea structura:

import javax.servlet.;
import javax.servlet.http.*;
import java.io.”;

import java.util.*;

public class Hello extends HttpServlet {
/**Process the HTTP Get request®*/
public void doGet(HttpServietRequest request, HitpServietResponse response)
throws IOException, ServletException
{
response.setContentType("text/html");
PrintWriter out = response.getWriter();
String name = request.getParameter("name");
out.printin("<htmI>");
out.printin("<body>");
out.printin("<head>");
out.printin("<title>Hello, " + name + "</title>");
out.printin("</head>");
out.printin("<body>");
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out.printin("<h1>Hello, " + name + "</h1>");
out.printin("</body>");
out.printin("</htm[>");

}
}

Prin metoda getParameter a clasei HttpServletRequest sunt preluati parametrii cererii (in
cazul nostru name), iar prin intermediul clasei HttpServietResponse, este construit raspunsul sub
forma unui HTML.

HTML-ul care lanseaza cererea spre servlet-ul Hello, are urmatoarea structura:

<html>

<head>

<title>Introductions</title>

</head>

<body>

<form method = get action="servlet/Hello">
If you don't mind me asking, what is your name?
<input type=text name="name"><p>

<input type =submit>

</form>

</body>

</html>

Observatii

1. Daca lucrati cu Java Builder, pentru cele doua aplicatii se va crea cate un proiect. Clasele
create in cadrul proiectelor nu trebuie incluse in pachete. In proiect trebuie incircat si
libraria “Tomcat\Common\lib\servlet.jar”. Se genereaza fisierele *.class prin comanda
make.

2. Fisierele *.class si *.html trebuie copiate in structura de directoare din Tomcat (vezi
tabelul 1).

3. Daca serverul Tomcat nu poate fi pornit, trebuie verificatd existenta variabilelor
Environment (My Computer\Properties\Advanced): JAVA HOME (calea spre JDK) si
CATALINA HOME (calea spre Tomcat). In cazul in care nu existi, ele trebuie create.

4. Daca serverul Tomcat ruleaza, aplicatia este pornita printr-un Browser Web (Internet
Explorer — vezi tabelul 2).

[ct

Pentru realizarea unei aplicatii web in ASP.NET sunt necesari urmatorii pasi:

e Se porneste Visual Studio;

e Se creeazd un proiect nou ASP.NET Empty Project; Proiectul creeat va contine initial
Properties, References si web.config. In aplicatia de fata nu va fi nevoie editarea
niciuneia dintre acestea.

e Se adauga o noud pagind in proiect din File->New File, (Ctrl+N) sau selectand proiectul
in Solution Explorer si dand click dreapta pe acesta apoi selectdnd din meniul care apare
Add -> New Item;

e Din fereastra care apare se selecteazd Web Form si se da un nume acesteia, apoi se apasa
Add;

o Urmeaza editarea paginii adaugate.
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Se adauga in pagind urmatoarea secventa de cod:

<label>
If you don't mind me asking, what is your name?
</label>
<br />
<br />
<asp:TextBox runat="server" ID="txtBoxNameResponse"></asp:TextBox>
<br />
<asp:Button runat="server" ID="btnOkResponse" Text="0Ok"
OnClick="btnOkResponse_Clicked" />

Elementele pe care este posibil sa nu le recunoasteti pAna acum sunt:
<asp:TextBox runat="server" ID="txtBoxNameResponse"></asp:TextBox>

acesta reprezentand un control asemanator unui ‘input’ de tipul ‘text’, cu diferenta ca acesta
ruleaza pe server, avand control total asupra Iui Tn momentul unui postback.

<asp:Button runat="server" ID="btnOkResponse" Text="0Ok"
OnClick="btnOkResponse_Clicked" />

asemandtor cu un ‘input’ de tipul ‘text’, cu aceleasi caracteristici ca i controlul anterior, iar
evenimentul ‘OnClick’ se va executa pe server.

Pentru ca pagina sa functioneze, trebuie adaugat handler-ul evenimentului asociat butonului.
Acesta este urmatorul:

protected void btnOkResponse_Clicked(object sender, EventArgs e)
{

}

Response.Write("Welcome " + this.txtBoxNameResponse.Text + "!");

Response reprezintd obiectul care va fi returnat clientului care a facut cererea. El contine deja
toate elementele initiale. Metoda Write a acestuia va adauga la inceputul raspunsului ceea ce este
trimis ca parametru, in cazul de fatd va fi : "Welcome x !”, unde ‘X’ reprezinta continutul casutei
text cu id-ul ‘txtBoxNameResponse’. Pentru a testa pagina este suficient sa apasati FS sau sa
dati click pe Debug -> Start Debugging, eventual Start Without Debuging. Pagina se va deschide
in browser, fiind afisate pe pagina textul, o casutd de introducere text si un buton. In momentul
apasarii butonului, se va afisa un mesaj la inceputul paginii care va contine si textul din casuta
(daca exista).

Cea de-a doua metoda va seta continutul unui element din pagina cu textul ce se gaseste
in casuta text.

protected void btnOkPostback_Clicked(object sender, EventArgs e)
{

var name = this.txtBoxNamePostback.Text;
this.IblPostBack.InnerText = "Welcome " + name + "!";

}

Pentru ca metoda aceasta sa functioneze, mai trebuie adaugat un element in forma, mai precis un
label, care sa ruleze pe server (runat="server”):

<label id="IblPostBack" runat="server" style="color: red" />

29



Cea de-a treia metoda foloseste tehnologia Ajax (Asynchronous JavaScript and XML) pentru a
comunica cu serverul. Elementele schimbate sunt:

<label id="IblAjaxResponse" style="color: red">

</label>
<input type="text" id="txtBoxAjax" width="50px"></input>
<input type="button" id="btnOkAjax" value="Ok" name="0Ok"
onclick="javascript:btnOkAjax_Clicked(txtBoxAjax.value);" />

Dupa cum se observa, aceste elemente sunt standard Html nefiind specifice ASP.NET; se pot
utiliza si cele .NET, insd nu este necesar accesul lor de pe server. Pentru a realiza un apel Ajax
pe server trebuie sd avem declarat in pagind un element nou:

<asp:ScriptManager ID="ScriptManager1" runat="server"
EnablePageMethods="true">
</asp:ScriptManager>

Acesta trebuie sa aiba atributul EnablePageMethods neaparat pe ‘true’. Dupa cum probabil ati
observat, evenimentul ‘onclick’ al butonului este o metoda javascript. Un exemplu de astfel de
metoda este urmatorul:

<script type="text/javascript">
function btnOkAjax_Clicked(name) {
try {
PageMethods.NameEntered(name, OnNameEnteredComplete);
} catch (e) {
alert(e.Message);

}
}

function OnNameEnteredComplete(retVal, e) {
if (retVal I= null) {
var IblAjaxResponse = document.getElementByld("IblAjaxResponse");
if (IblAjaxResponse != null) {
IblAjaxResponse.innerText = retVal;

}
}
}

</script>

Arata ca o functie normald, exceptand obiectul ‘PageMethods’. Acesta se regaseste in pagina in
urma adaugarii ‘ScriptManager’-ului §i a atributului precizat. El permite apelul metodelor de pe
server. Metoda care este apelata se numeste ‘NameEntered’, Tnsa numarul de parametri este
diferit de cel de pe server, mai precis, In apel este permis sa avem 3 metode ca parametri:
OnComplete, OnSuccess si OnError, insa de obicei este suficient OnComplete. Primul
parametru este cel care va fi primit in metoda de pe server.

Pe server avem urmatoarea metoda:

[WebMethod]
public static string NameEntered(string name)

{
}

return "Welcome " + name + "!";

Se observa ca metoda aceasta prezinta trei diferente fatd de cele prezentate anterior:
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e Detine atributul [WebMethod]; va fi necesara folosirea unei noi librarii pentru acest
atribut (using System.Web.Services;) ce se adauga deasupra declaratiei clasei sau a
namespace-ului.

e Metoda este publicd, altfel nu va fi posibil accesul la ea;

e Returneaza un ‘string’.

Dupa apelul metodei, raspunsul va fi primit in functia javascript ‘OnNameEnteredComplete’
unde se trateazd rezultatul.

Aplicatii
1. Implementati aplicatia prezentata in lucrare.

2. Realizati o aplicatie servlet care sd permita gestionarea unei baze de date MySQL.:
e conectarea la baza de date MySQL;
e introducerea unei noi inregistrari;
o afisarea rezultatelor interogarilor intr-un tabel.

Pentru aceasta aplicatie va fi creat HTML-ul, clasa DBServlet care extinde clasa HttpServiet
si clasa DBConnection preluata din lucrarea anterioara (Conectarea la o baza de date
MySQL). Driverul de MySQL mm.mysq!-2.0.12-bin.jar trebuie pus in directorul /ib din Web-
inf (vezi tabelul 1).

3. Implementati aplicatia 2 iIn ASP.NET.
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7. Aplicatii distribuite

&

Java RMI (Remote Method Invocation) permite implementarea aplicatiilor distribuite
Java-to-Java, in care metodele obiectelor pot fi apelate la distanta [13]. Astfel, o aplicatie client
poate folosi la distantd obiectele unei aplicatii server. O clasa poate fi instantiata la distantd, daca
ea implementeaza o interfatd Remote. Figura 4 prezintd structura generald a unei aplicatii Java
RML

Caller Remote
object

A 4 A\ 4

Remote interface
STUB SKELETON

marshal / unmarshal

unmarshal / marshal

A
\ 4

Figura 4. Structura unei aplicatii Java RMI

La apelul unei metode la distanta are loc urmatoarea secventa de operatii:

— Clientul apeleaza metoda;

— Componenta STUB primeste apelul, serializeazd parametrii §i 1i trimite apoi spre
componenta SKELETON a serverului;

— Componenta SKELETON primeste apelul, deserializeazd parametrii si 1i trimite
serverului;

— Serverul primeste apelul si parametrii, apeleazd metoda local si trimite rezultatul
componentei SKELETON;

— Componenta SKELETON primeste rezultatul, 1l serializeaza si 1l trimite mai departe
componentei STUB a clientului;

— Componenta STUB primeste rezultatul, 11 deserializeaza si 1l transmite apelantului;

— Clientul primeste rezultatul metodei apelate.

In aceasti lucrare este prezentati o aplicatic Java RMI in care clientul apeleaza la
distantd metoda sayHello a aplicatiei server. Aceasta metoda returneaza mesajul “Hello World!”.
Mesajul este preluat si afisat de client. Interfata Hello contine antetul metodei sayHello pe care
dorim sd o apelam la distanta.
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import java.rmi.Remote;
import java.rmi.RemoteException;

public interface Hello extends Remote {
String sayHello() throws RemoteException;
}

Clasa unui obiect apelabil la distanta trebuie sd implementeze cel putin o interfatd Remote. Clasa
Hellolmpl implementeaza interfata Hello de tip Remote, si ea reprezinta aplicatia server. Metoda
main a serverului creeaza o instantd a clasei Hellolmpl, rezultand astfel obiectul ale carui metode
pot fi apelate la distantd. Acestei instante i se asociaza numele “Hello” in registrele RMI.

import java.rmi.server.UnicastRemoteObject;
import java.rmi.RemoteException;

import java.rmi.RMISecurityManager;

import java.rmi.Naming;

import java.io.”;

import java.net.”;

import sun.security.util.*;

public class Hellolmpl extends UnicastRemoteObject implements Hello{

public Hellolmpl() throws RemoteException {
super();
}

public String sayHello() {
return "Hello World!";
}

public static void main(String args[]) {
if (System.getSecurityManager() == null) {
System.setSecurityManager(new RMISecurityManager());
}

try {
Hellolmpl obj = new Hellolmpl();
/I se atribuie instantei acestui obiect numele "Hello"
Naming.rebind("//localhost/Hello", obj);
System.out.printin("Hello bound in registry");

} catch (Exception e) {
System.out.printin("Hellolmpl err: " + e.getMessage());
e.printStackTrace();

Compilarea serverului se efectueaza prin comenzile JDK:
javac server\HelloImpl.java
rmic -d . server.Hellolmpl
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Dupa inregistrarea obiectului, acesta poate fi cautat de aplicatiile client, folosind metoda
Naming.lookup(), prin numele care i s-a asociat in registrele RMI. Aplicatia prezentata mai jos

apeleaza la distantd metoda sayHello a serverului, si afiseaza mesajul returnat: “Hello World!”.
import java.rmi.Naming;
import java.rmi.RMISecurityException;

public class SayHello {

public static void main(String argsl]) {
String message = "blank";
if (System.getSecurityManager() == null) {
System.setSecurityManager(new RMISecurityManager());
}

try {
Hello hello = (Hello)Naming.lookup("//localhost/Hello");
message = hello.sayHello();

} catch (Exception e) {
System.err.printin("Hello-exception: " + e.getMessage());
e.printStackTrace();

}

System.out.printin(message);

Compilarea clientului se efectueaza prin comanda JDK:
javac client\SayHello.java

Aplicatia poate fi rulata prin urmatoarele comenzi JDK:
rmiregistry
java -Djava.rmi.server.hostname=localhost -Djava.security.policy=java.policy Hellolmpl
java -Djava.security.policy=java.policy SayHello localhost 20

[c¥

.NET Remoting

Pentru realizarea aplicatiilor .NET Remoting, cele doud programe (server si client)
necesitd versiunea 3.5 de .NET Framework pentru a functiona. Solutia este creatd in Visual
Studio 2010. Pentru a rula programele din Visual Studio se poate da un 'RUN' simplu deoarece
atat clientul cat si serverul sunt setate ca startup projects. Programele pot fi rulate si prin figierele
'runClient.bat' si 'runServer.bat'. Atat portul de ascultare al serverului si URL-ul pentru obiectul
care este apelat la distanta cat si adresa la care se conecteazad clientul pot fi modificate din
fisierul app.config al fiecdrui executabil (aflat in bin/Debug/) fard a necesita recompilarea
programelor. Urmeaza in continuare aplicatia .NET Remoting in care clientul apeleazd la
distantd metoda sayHello a aplicatiei server. Sunt prezentate: interfata (folositd pentru
comunicatie intre client si server), serverul si clientul.
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Interfata

/I The interface used to communicate between the client and
I the server using .NET Remoting.
public interface IHello

/I Returns a 'hello world' message to the caller.
/I <returns>The message</returns>
string SayHello();

}

Serverul

using System;
using Infrastructure;

/I A remotable object (MarshalByRefObject makes it remotable) that implements the IHello interface.
public class Hello : MarshalByRefObject, IHello

{

#region Implementation of IHello

/I Returns a 'hello world' message to the caller.
/I <returns>The message</returns>

public string SayHello()

{

}

#endregion

return "Hello from the IHello implementation on the server.";

using System;

using System.Configuration;

using System.Runtime.Remoting;

using System.Runtime.Remoting.Channels;
using System.Runtime.Remoting.Channels.Tcp;

class Program
{
static void Main(string[] args)
{
AppSettingsReader reader = new AppSettingsReader();
int port = (int)reader.GetValue("port", typeof(int));
string objectURL = (string)reader.GetValue("objectURL", typeof(string));

/I Creating a TcpChannel on the 8888 port and binding it for use.
TcpChannel channel = new TcpChannel(port);
ChannelServices.RegisterChannel(channel, true);

/I Registering the Hello class on the 'tcp://localhost:8888/hello’ address.

/I When the Activator.GetObject method is called this is the URL that will have to be given to
access the IHello interface.

RemotingConfiguration.RegisterWellKnownServiceType(typeof(Hello), objectURL,
WellKnownObjectMode.SingleCall);

/I Waiting for any clients to use the server.
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Console.WriteLine("The server is ready, press any key to close the console");
Console.ReadKey();
}
}

Fisierul de configurare al serverului

<?xml version="1.0"?>
<configuration>
<startup>
<supportedRuntime version="v2.0.50727"/>
</startup>
<appSettings>
<add key="port" value="8888"/>
<add key="objectURL" value="hello"/>
</appSettings>
</configuration>

Clientul

using System;

using System.Configuration;

using System.Runtime.Remoting;

using System.Runtime.Remoting.Channels;
using System.Runtime.Remoting.Channels.Tcp;
using System.Threading;

using Infrastructure;

class Program

static void Main(string[] args)

{
AppSettingsReader reader = new AppSettingsReader();

string serverObjectURL = (string)reader.GetValue("serverObjectURL", typeof(string));
Thread.Sleep(1000); // Wait for the server to start.

IHello hellolmplementation = null;

/I Creating a TcpChannel and binding it in order to use it for Remoting.

TcpChannel channel = new TcpChannel();
ChannelServices.RegisterChannel(channel, true);

try

/I The activator will look for any bound implementation of the IHello interface on the specified

URL.
hellolmplementation = Activator.GetObject(typeof(IHello), serverObjectURL) as IHello;

catch (RemotingException rex)

Console.WriteLine(string.Format("Error: RemotingException encoutered - {0}", rex.Message));

catch (MemberAccessException maex)

Console.WriteLine(string.Format("Error: MemberAccessException encoutered - {0}",
maex.Message));
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/I Calling the SayHello method through the implementation.
string message = hellolmplementation.SayHello();
Console.WriteLine(string.Format("The server says: '{0}", message));

Console.WriteLine("Press any key to close the console");
Console.ReadKey();

Fisierul de configurare al clientului

<?xml version="1.0"?>
<configuration>
<startup>
<supportedRuntime version="v2.0.50727"/>
</startup>
<appSettings>
<add key="serverObjectURL" value="tcp://localhost:8888/hello"/>
</appSettings>
</configuration>

Windows Communication Foundation

Tehnologia .NET Remoting a fost inlocuitd cu Windows Communication Foundation (WCF)
care permite crearea aplicatiilor orientate pe servicii, inclusiv a unor aplicatii client-server cu
metode declarate in server si apelate din client. Clientul si serverul sunt independenti din punct
de vedere al sistemului de operare sau al limbajului de programare. In continuare, este prezentati
aplicatia WCF in care clientul apeleaza la distantd metoda sayHello a aplicatiei server. Visual
Studio trebuie sa aiba instalat pachetul WCF (din Tools -> Get Tools and Features -> Individual
Components). Interfata trebuie sa existe atat in server cat si in client. Serverul trebuie sa fie

proiect de tip consold .NET Framework.

Interfata

using System;

using System.Collections.Generic;
using System.Ling;

using System.ServiceModel;
using System.Text;

using System.Threading.Tasks;

namespace Lab5_Server

[ServiceContract]
public interface IWCF Server

[OperationContract]string SayHello();
}
}
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Serverul

using System;

using System.Collections.Generic;
using System.Lingq;

using System.Text;

using System.Threading.Tasks;

namespace Lab5_Server

internal class WCFServer : IWCFServer

{
public string SayHello()

{
return "Hello from the IHello implementation on the server.";
}
}
}

using System;

using System.Collections.Generic;
using System.Lingq;

using System.ServiceModel;
using System.Text;

using System.Threading.Tasks;

namespace Lab5_Server
internal class Program
static void Main(string[] args)
{ NetTcpBinding binding = new NetTcpBinding();
Uri baseAddress = new Uri("net.tcp://localhost:8000/wcfserver");

using (ServiceHost serviceHost = new ServiceHost(typeof(WCFServer), baseAddress))

{
serviceHost.AddServiceEndpoint(typeof(IWCFServer), binding, baseAddress);
serviceHost.Open();
Console.WriteLine($"The WCF server is ready at {baseAddress}.");
Console.WriteLine("Press <ENTER> to terminate service...");
Console.WriteLine();
Console.ReadLine();
}
}
}
}
Clientul

using System;

using System.Collections.Generic;
using System.Ling;

using System.ServiceModel;
using System.Text;

using System.Threading.Tasks;
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namespace Lab5_Client
internal class Program
static void Main(string[] args)

NetTcpBinding binding = new NetTcpBinding();

string url = "net.tcp://localhost:8000/wcfserver";

EndpointAddress address = new EndpointAddress(url);

ChannelFactory<IWCFServer> channelFactory = new ChannelFactory<IWCFServer>(binding,

address);
IWCFServer server = channelFactory.CreateChannel();
Console.WriteLine(server.SayHello());

}
}
}

Aplicatii
1. Sa se implementeze aplicatia prezentata in lucrare.

2. Sa se implementeze o aplicatie Java RMI, .NET Remoting sau WCF, pentru apelul la distanta
al unor metode care sa efectueze operatiile aritmetice elementare.

3. Sa se integreze clientul de MySQL implementat anterior intr-o aplicatie Java RMI, .NET
Remoting sau WCF.
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8. Algoritmi paraleli

Algoritmii paraleli [6] folosesc resursele specifice unui sistem de calcul paralel (un
numdr de p procesoare) pentru rezolvarea unei probleme. Un algoritm secvential poate fi
paralelizat daca secventa de operatii elementare generatd poate fi descompusa in p subsecvente,
in asa fel incdt operatiile din fiecare subsecventd sd poatd fi executate concurential de
procesoarele disponibile. Existd situatii in care aceastd descompunere este naturald, in general
insd, algoritmul secvential cel mai natural pentru rezolvarea unei probleme nu conduce la o
impartire in astfel de subsecvente [6]. Caracteristicile specifice aplicatiilor paralele bazate pe
Message Passing Interface (MPI) sunt prezentate in [10].

@

MPJ express este o implementare Java pentru standardul MPI. Pentru a instala si utiliza
acest pachet sub Windows se recomanda utilizarea mediului de dezvoltare NetBeans. MPJ
necesitd Java 1.5 SDK sau o versiune superioard. Pachetul de instalare poate fi descarcat de pe
www.sun.org. De  asemenea, se poate instala doar NetBeans de pe
http://netbeans.org/downloads/index.html. Se descarcd MPJExpress de la http:/mpj-
express.org/download.php. Este necesara autentificarea, dar inregistararea este gratuita.

In MyComputer->Properties->Advanced Tab-> Environment Variables trebuie adaugata
variabila:

MPJ HOME = [cale citre mpj (ex: C:\MPJ)]

si trebuie adaugata la variabila PATH, calea catre directorul bin (ex: C:\MPJ\bin). De aici inainte
se presupune ca pachetul MPJ Express este instalat in C:\MPJ. In C:\MPJ\bin se afli
installmpjd-windows.bat. Acest batch file, trebuie rulat pentru a instala serviciul necesar rularii
aplicatiilor MPI. Dupa ce a fost instalat, poate fi pornit din Start->Run-> service.msc. Din lista
de servicii trebuie selectat MPJ Daemon si pornit.

Se creeaza un proiect nou, File->New Project->Java->Java Application. Presupunem ca
acesta se va numi MPJHello. In tab-ul cu ierarhia proiectului, trebuie adaugate librariile mpi.jar
si mpj.jar prin click dreapta pe MPJ->Libraries, apoi Add JAR/Folder... In tab-ul Files, in
directorul proiectului MPJHello trebuie creat fisierul mpj.conf. Acesta va contine urmatoarele:

# Number of processes

3

# Protocol switch limit

131072

# Entry in the form of machinename@port@rank
localhost@20000@0

localhost@20020@1

localhost@20030@?2

Pentru fiecare masind/proces trebuie creatd o configuratie pentru rulare. Pe tab-ul
Projects, click dreapta pe MPJHello -> Set Configuration -> Customize si din panoul din partea
dreaptd, se selecteazd New. Apoi se selecteaza numele. De exemplu mpj0. In cdsuta de text
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Arguments se va specifica: 0 mpj.conf niodev , unde prima cifrd este numarul procesului.
Pentru fisierul mpj.conf de mai sus, ar trebui create 3 configuratii:

mpj0: 0 mpj.conf niodev
mpjl: 1 mpj.conf niodev
mpj2: 2 mpj.conf niodev

In cazul in care se doreste rularea pe mai multe statii, pentru fiecare statie se va crea un fisier
mpj.conf ce va contine [P-urile si rangul tuturor statiilor.

Functiile de transfer sunt:

e Send(Object buffer, int offset, int count, Datatype type, int dest, int tag);
e Recv(Object buffer, int offset, int count, Datatype type, int src, int tag);

Unde Buffer este adresa tabloului trimis / primit, Offset este indexul in cadrul tabloului incepand
de la care dorim sa se trimitd / primeasca datele, Count este numarul de elemente trimise /
primite, Type este tipul de date (ex. MPL.CHAR, MPLINT, MPL.OBJECT, etc.), Dest este rangul
(identificatorul) procesului destinatie, Src este rangul (identificatorul) procesului sursa, iar Tag
este un identificator unic al mesajului (cel din Recv trebuie sd corespunda cu cel din functia
Send aferentd).

In continuare se prezinta aplicatia PingPong in care are loc un transfer de mesaje intre p
procese, care pot fi pornite pe calculatoare diferite. Procesul 0 primeste si afiseazd numele
statiilor pe care au fost pornite celelalte procese. Dupa cum se poate observa in codul sursa al
aplicatiei, prezentat mai jos, aceste transferuri de mesaje sunt efectuate prin instructiunile Send
si Recv existente 1n libraria MPI.

import mpi.MPI;

public class MPJHello {
public static void main(String[] args) {
MPL.Init(args);
int me = MPI.COMM_WORLD.Rank();
int size = MPI.COMM_WORLD.Size();
if(me==0)Y
System.out.printin("Node "+me+" is running");
for(int dest=1; dest<size; ++dest){
System.out.printin("Sending to node " + dest);
String s = "Hello from node 0";
char[] message = s.toCharArray();
charf] str = new char[100];
MPI.COMM_WORLD.Send(message, 0, message.length, MPI.CHAR, dest, 0);
MPI.COMM_WORLD.Recyv(str, 0, 100, MPI.CHAR, dest, 0);
System.out.printin(new String(str).trim());
}
}

else{
char{] str = new char[100];
String s = "Hello from node " + me;
char[] message = s.toCharArray();
MPI.COMM_WORLD.Recv(str, 0, 100, MPI.CHAR, 0, 0);
MPI.COMM_WORLD.Send(message, 0, message.length, MPI.CHAR, 0, 0);

}
MPI.Finalize();
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Pentru a rula programul, trebuie setate pe rand configuratiile de rulare. Mai intai trebuie sa ne
asiguram ca proiectul curent este setat ca MainProject:

Run -> Set Main Project -> MPJHello.

Trebuie selectatd prima configuratie:
Run->Set Project Configuration-> mpj0

Apoi se ruleaza aplicatia (F6). La fel trebuie procedat pentru restul configuratiilor (mpj1, mpj2).
Dupa ce toate acestea au fost pornite, va incepe executia programului.

[c¥

Limbajul C# permite implementarea aplicatiilor paralele printr-o librarie MPI [14].
Pentru intelegerea structurii unui program paralel implementat in MPLNET, aceastd lucrare
prezintd aplicatia PingPong in care are loc un transfer de mesaje intre p procese, care pot fi
pornite pe calculatoare diferite. Procesul 0 primeste si afiseazd numele statiilor pe care au fost
pornite celelalte procese. Dupa cum se poate observa in codul sursa al aplicatiei, prezentat mai
jos, aceste transferuri de mesaje sunt efectuate prin instructiunile Send si Receive existente in

libraria MPI.

/* Copyright (C) 2007 The Trustees of Indiana University

* Use, maodification and distribution is subject to the Boost Software
* License, Version 1.0. (See accompanying file LICENSE_1_0.txt or copy at
* http://www.boost.org/LICENSE_1_0.txt)

* Authors: Douglas Gregor
* Andrew Lumsdaine

* This test exercises Communicator.ReduceScatter.
*/

using System;

using MPI;

class PingPong

static void Main(string[] args)

{

using (new MPI.Environment(ref args))

{

Intracommunicator comm = Communicator.world;
if (comm.Rank == 0)

Console.WriteLine("Rank 0 is alive and running on " + MPIl.Environment.ProcessorName);
for (int dest = 1; dest < comm.Size; ++dest)

Console.Write("Pinging process with rank " + dest + "...");
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comm.Send("Ping!", dest, 0);

string destHostname = comm.Receive<string>(dest, 1);

Console.WriteLine(" Pong!");

Console.WriteLine(" Rank " + dest + " is alive and running on " + destHostname);

}
}
else

{
comm.Receive<string>(0, 0);
comm.Send(MPI.Environment.ProcessorName, 0, 1);

}
}
}
}

Pentru transfer de date simple (int, string, etc.) de la un proces la altul functiile blocante Send si
Receive se apeleazd dupa cum urmeaza:

Send<type>(d_src, proc_dest, tag);
d_dest = Receive<type>(proc_src, tag);

unde type reprezintd tipul datelor transmise, d src / d dest reprezintd variabila care contine
valoarea inainte / dupd transfer, proc src / proc dest reprezintd codurile proceselor sursa /
destinatie, iar tag ne permite sa formam perechi send / receive (datele sunt receptionate de la
procesul sursa doar daca tag-urile corespund).

Pentru transfer de tablouri se pot folosi variantele:

Send(d_src, proc_dest, tag);
Receive(proc_src, tag, ref d_dest);

sau, pentru transfer de matrici:

Send(d_src, proc_dest, tag);
Receive(proc_src, tag, out d_dest);

Variantele neblocante ale functiilor de transfer sunt ImmediateSend respectiv ImmediateReceive.
In cazul unui apel al functiei Barrier sistemul va astepta ajungerea tuturor proceselor la bariera,
permitand astfel sincronizarea acestora. O altd posibilitate de sincronizare constd in apelul
functiei Wait a obiectului Request returnat de o operatie de transfer neblocanta, determinand
astfel asteptarea finalizarii operatiei respective. Prin apelul metodei Test a unui obiect Request se
poate determina daca operatia neblocanta aferenta s-a terminat.

Pentru dezvoltarea aplicatiilor paralele folosind MPLNET trebuie instalat MPLLNET SDK, iar
pentru rularea acestora se instaleaza Microsoft Compute Cluster Pack SDK (sdk x86.msi) [14].

Orice aplicatice MPLNET trebuie sa aiba introdusa o referinta la libraria MPI.dII.

Aplicatiile MPI pot fi pornite pe statia locala (localhost) prin urmatoarea comanda:
mpiexec —n nr_procese NumeAplicatie.exe

De exemplu, comanda
mpiexec —n 5 PingPong
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va porni aplicatia PingPong pe cinci procese, toate pe statia locala.
Pentru rularea pe mai multe statii, se copiaza executabilul programului pe care vrem sa-l rulam
in folderul Microsoft Compute Cluster Pack\Bin\ al fiecarei statii folosite si se porneste
executabilul smpd pe fiecare statie, prin comanda:
smpd —d
Apoi se va folosi una din urmatoarele comenzi:
mpiexec —hosts nr_statii nume statie 1 nume statie 2 nume statie n PingPong
mpiexec —hosts nr_statii nume_stl nr_procese nume stn nr procese PingPong

mpiexec —machinefile machine.file —n nr procese PingPong
unde machine.file contine fiecare statie pe cate un rand.

Exemple

Comanda efectuata pe statie10:
mpiexec —hosts 4 statiel0 statie07 statie09 static08 PingPong
porneste patru procese pe patru statii diferite (staie10, statie07, statie09 si static08). Prima statie
trebuie sa fie cea locala!
Comanda efectuata pe statie10:
mpiexec —hosts 4 statiel0 3 statie07 2 statie09 5 statie08 6 PingPong
foloseste patru statii, pornind trei procese pe statia locala (statie10), doua procese pe statie07,

cinci procese pe statie09, respectiv sase procese pe statie08. Si in acest caz prima statie trebuie
sa fie cea locala!

Aplicatii

1. Sase implementeze si sa se ruleze aplicatia PingPong prezentata in lucrare.

2. Sa se implementeze un algoritm paralel care calculeaza suma elementelor unui tablou.
3. Sa se implementeze un algoritm paralel care determind maximul dintr-un tablou.

4. Sa se implementeze un algoritm paralel care determind minimul dintr-o matrice.

5. Sa se implementeze un algoritm paralel care determina suma elementelor unei matrici.
6. Sa se implementeze un algoritm paralel pentru adunarea matricilor.

7. Sa se implementeze un algoritm paralel pentru inmultirea matricilor.

8. Sa se implementeze si s se ruleze algoritmul Quicksort paralel.

9. Sa se implementeze si sa se ruleze algoritmul Mergesort paralel.

10. Sa se implementeze paralelizat problema celor n regine.
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